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Source Water Assessment Viewer User Guide 
April 29, 2010, version 5
_________________________________________________________________ 
 
Introduction to Source Water Assessment Viewer 
Getting started 
What layers does the Viewer display? 
What does “Visible” and “Active” mean? 
What tools are available? 
What other functions are available? 
How to download PWS digital data layers?  
How to obtain other data layers? 
How to contact us? 
 

Introduction to the Source Water Assessment Viewer 
 
The Source Water Assessment Viewer (Viewer) is designed to allow the public to 
view the spatial datasets used and created during the source water susceptibility 
assessment process.  More than 6,000 Public Water Systems (PWS) are the 
primary audience.  PWS will use the Viewer to identify and validate potential 
sources of contamination (PSOC) that are found within their source water 
protection areas.  Agency staff, consultants, and the general public constitute the 
secondary audience. 
 
The Viewer enables internal and external customers to view PWS wells and 
intakes along with the PSOC and capture zones used for source water 
assessments. 
 
It allows users to perform multiple functions, such as: 

• Access to PWS source assessment information. 
• View and print maps of source water protection areas and associated 

PSOC. 
• Obtain more details about the selected public water source.
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Getting Started 
Computer and Internet Browser Settings 

The following computer and Internet browser settings are recommended and 
approved for proper interface display and optimum Viewer performance and 
functionality: 

1) Computer Settings 

 Operating System – Microsoft Windows XP 

2) Internet Browser Settings 

a. Acceptable Internet Browsers  

i. Internet Explorer 6.0 and 7.0 

ii. Firefox 2.0 and 3.0 

b. Browser Text Size – Make sure the text size is set to one of the 
following size options: 

i. Go to View menu > Select Text Size 

ii. Select Medium, Smaller or Smallest 

c. Internet Settings- You may need the following for your Internet content 
settings: 

i. Enable Pop-ups if necessary 

A yellow bar will be displaying just below the Menu Bar if the pop-
ups are blocked in your Internet browser.  Right-click on the 
yellow bar to unblock the pop-ups as prompted. 

ii. Clear Cache and Cookies of your browser if necessary. 

You don’t need to make the following setting changes if this is 
first time you are using the Viewer. The only time you need to 
make these changes is when the browser cached the old 
interface information and you cannot see any new updates to the 
Viewer. The following are the instructions to clear Cache in IE 
and Firefox. 

- How to clear Cache in Internet Explorer 6.0 & 7.0: 
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1) Go to Tools >Select Internet Options >Select the 
Delete… button, in the Browsing history section. 
 
2) Click the “Delete files” and “Delete cookies” buttons. 

 
   - How to clear Cache in Firefox: 
 

1) Go to Tools >Clear Private Data… 
 

2) Make sure the following three items: Cache, Cookies and 
Offline Website Data are checked.  Then click Clear 
Private Data Now button (see Figure 1). 

 

  Figure 1 
 

There are two ways to access the Viewer: 
 
Click the Source Water Assessment Viewer link on Agency’s ArcIMS Geographic 
Data Viewers page http://www.tceq.state.tx.us/gis/ViewerIndex.html.  Or... 
 
Open the Drinking Water Watch (DWW) application 
(http://dww.tceq.state.tx.us/DWW/ ).  Once you have selected a water system click 
the Water System Facilities link on the left (see Figure 2a). 
 

Figure 2a 
 
Then scroll thru the facilities list to find the source you are interested in.  Click the 
link on the right that says “SWA Viewer” (see Figure 2b).  The Viewer will open 
and zoom to the source specified. 
 

http://www.tceq.state.tx.us/gis/ViewerIndex.html�
http://dww.tceq.state.tx.us/DWW/�
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Figure 2b 
 
There are two ways to easily find a PWS on the Source Water Assessment 
Viewer: 

 Reminder: 
 

When the Viewer is talking to the server, the “Application Loading…” text 

will display on the toolbar of the Viewer . Users 
need to wait until the text has gone away and the Overview Map has 
finished displaying before tools can be used in the Viewer. Otherwise, an 
“Error retrieving data” message may be displayed. 

 
1) Use the PWS search function 
 

You can locate a PWS by using the search function at the bottom of the 
web interface (Figure 3): 
 

 Figure 3 
 
Select a source type from the dropdown list, type in a valid PWS 
number, and click the “Find PWS” button when finished.  The Viewer will 
zoom to and highlight the water source(s) with the provided source type 
and PWS number. 

 
2) Use the Drinking Water Watch application 
 

As described at the bottom of page 3, when you click the “SWA Viewer” 
link in the DWW application (as shown in Figure 2b above) the viewer 
will open, zoom to, and highlight the source in green that matches your 
selection (see Figure 4). 

Figure 4 
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What data layers does the Viewer display? 
 
Please refer to the layers listed below in the Viewer’s Table of Contents (TOC) to 
see which data layers are displayed in the Viewer. 
 

PWS Well* 
PWS Surface Intake* 
Potential Sources of Contamination 
Pipelines 
Area of Primary Influence* 
2 Year Time of Travel Capture Zone* 
5 Year Time of Travel Capture Zone* 
10 Year Time of Travel Capture Zone* 
20 Year Time of Travel Capture Zone* 
50 Year Time of Travel Capture Zone* 
100 Year Time of Travel Capture Zone* 
Half Mile Fixed Radius Capture Zone* 
PWS Reservoir 
Truncated Watershed* 
TWDB Well Location Grid 
Highways 
Local Streets 
Waterbodies 
Hydro 
TCEQ Regions 
TX Counties 
Cities 
Hypsography 
Houston Imagery 
DFW Imagery 
DOQQs 
DRGs 
Minor Aquifers 
Major Aquifers 
Geologic Atlas of Texas Fault 
Geologic Atlas of Texas 
Landuse 
US States 
Mexico Rivers 
Mexico States 

 
The Viewer displays Program Area and Base layers within the map frame 

• Program Area layers that are available for download from the Viewer are 
indicated in the above list with an asterick. 
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• Base layers provide reference which allow us to tie our PWS digital layers 
to known locations on the earth.  The base layers available for download 
from external web sites are: highways, local streets, waterbodies, streams, 
cities and counties. See “How to obtain other data layers?” for more details. 

 
Refer to the Legend to see how each layer in the TOC is displayed in the Viewer.  
In the legend, each symbol is described.  The symbol has a unique color and 
feature (point, line, or polygon), which illustrates how the Viewer uniquely displays 
each data layer.  The legend (see Figure 5) can be viewed by clicking the  
Legend toggle. 
 

  Figure 5 
 
A printable legend can be accessed thru the “Get SWAV legend” tool by clicking 
the  icon on the main toolbar. 
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What Does "Visible" and "Active" Mean? 
The  folder contains a list of all the available map layers which may be 
displayed within the Viewer’s map frame (see Figure 6). 
 

 Figure 6 
 
Each data layer has a check box  and a radio button  located to the left of its 
layer name.  The first column of boxes indicates which layers are currently visible 
in the Viewer’s map frame.  An empty box  indicates the layer is not visible, 
while a checked box  indicates the layer is visible.  Multiple layers may be turned 
on at the same time.  The Viewer’s map frame will instantly refresh as map layers 
are turned off and on by the user. 
 
However, if an asterisk “*” is located to the right of the layer’s name, this indicates 
that the layer may not be displayed at the current scale.  See the note below the 
list of layers stating the asterisk “Denotes No Availability at this Scale.” At the full 
extent of the state of Texas, note that the Local Streets and the Zip Codes layers 
may not be displayed.  It may therefore be necessary to zoom in further to a 
county-wide area to be able to view these data layers. 
 
The second column of radio buttons  indicates which layers are currently active 
in the Viewer’s map frame.  When the circle is filled in , the layer is active, if the 
circle is not filled in , the layer is inactive.
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What tools are available? 
 Get PWS Details: 

 
Placing the cursor on the  icon will display a brief instruction on how to use this 
tool. 
 
How to Use the Get PWS Details tool: 
 

1). Select the PWS Well or PWS Surface Intake layer to be active by checking 
the radio button before the PWS layer name. 

2). Select the Get PWS Details tool  
3). Single-click on the desired PWS Well or PWS Surface Intake. 
4). The tool will redirect the user from the selected PWS located in the Viewer 

to the corresponding PWS details. 
5). If there are multiple sources for the selected location, the user may select 

(single-click) one source at a time, from a list of sources, to obtain the 
additional PWS details (See Figure 7). 

 

  Figure 7 
 
Once a user has selected a Water Source ID from the Get PWS Details list, a new 
tab will open directly to the Drinking Water Watch Page for the selected PWS 
number (See Figure 8). 
 

 
Figure 8 
 
A user may navigate back to the Source Water Assessment Viewer by going back 
to the original internet browser tab. 
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 Get PDF Map/Get SWAV Legend: 
 
This tool is used to either print the current extent map displayed on the screen, or 
get the detailed description of the PSOC legend in a PDF document. 
 
Hovering the cursor over the  icon will show a choice of “Get PDF Map” and 
“Get SWAV Legend”. 
 

A)  Clicking on “Get PDF Map” will bring up a window as shown in Figure 9. 
After selecting one of the three given templates, click the “Get PDF Map” 
button.  It may take several minutes to generate a map in PDF in a separate 
window. Please be patient. 

 

  Figure 9 
 
If you are having trouble with your printer’s Page Setup, the following steps 
may assist you with your Printer Settings for 11 x 17 Maps: 
 

1) Open the Print dialog box 
2) Select Printer Properties 
3) Change Page Size from 8.5 x 11 to 11 x 17 
4) Change the Paper Orientation to either Portrait or Landscape 
5) Select OK 
6) Verify the following are selected in the Print Dialog Box: 

i) Page Scaling is set to “Fit to Printable Area” 
ii) “Auto Rotate and Center” is checked 

 
Note: See the “Print Preview” to verify all printer settings were made. 

 
B) Clicking on “Get SWAV Legend” will open up a PDF document of SWAV 

legend. 
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  Buffer Tool: 
 
This tool is used to create a user-defined buffer around a selected PWS well or 
surface intake.  In addition, the tool generates a tabular list of neighboring PWS 
sources located within the user-defined buffer distance from the selected PWS 
source.  Please be patient and wait until the buffer results are displayed in a 
separate pop-up window.  The tool’s response time may take up to 20 seconds 
before displaying the results.  The response time will depend on the buffer 
distance selected. 
 
How to Use the Buffer Tool: 

 
1). Make one of the following PWS source layers “active.” 

a. PWS Well  OR 
b. PWS Surface Intake 
 

2). Select the Buffer tool  
 
3). Single-click on the desired PWS source.  The selected PWS source will be 

highlighted in pink as displayed in Figure 10. 
 

  Figure 10 
 

4). Confirm your PWS source selection. 

 Figure 11 
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a. Select the OK button in Figure 11 to confirm that the pink highlighted 
source in Figure 25 is the one you want to create a buffer for.  Proceed 
to step 5) after you get the prompt to select a buffer distance from the 
buffer toolbar (see Figure 12). 

 

Figure 12 
 
b. If you did not select the correct Water Source # you wanted to buffer 

(see Figure 10), select the CANCEL button in Figure 11. Repeat step 1) 
if needed. 

 

  Figure 13 
 

5). Next, type in a buffer distance to the form and select a measure unit from 
the dropdown list located on the right side of the buffer tool. If invalid 
information is given, a message will prompt you to the correct ranges of 
buffer distance.  Click “Do Buffer” button to create the buffer on the map. 
See Figure 14. 
 

  Figure 14 
 

6). Buffer Results: 
 
a) A buffer is displayed in yellow.  See Figure 15 
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  Figure 15 
 

b) List of Neighboring water sources within the buffered area: 
 

  Figure 16 
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Map navigation tools: 
Pan Tools: 

Four pan tools (Figure 17) on the upper left of the main map allow the user 
to pan the map in four directions – north, south, east and west. 

  Figure 17 
 Zoom in: 

This tool allows you to zoom in on the map to view more detail for a 
selected area. The area displayed is based on the outer boundary (extent) 
of the box you draw. To zoom in, click and drag over an area on the map 
you want displayed. 

 Zoom out: 

This tool allows you to zoom out from the area displayed in the map. The 
area displayed is based on the extent of the box you draw. To view more 
map area, zoom out by clicking and dragging over an area on the map. 

 Full extent: 

This tool allows you to reset the map to the full extent of the state by 
clicking once on the button. This is the extent to which the application 
initially opens. 

 Fixed zoom in: 

One click on the button zooms in on the center of the data in your map to 
80% of the current scale. 

 Fixed zoom out: 

One click on the button zooms out from the center of the data in your map 
to 120% of the current scale. 

 Last Extent: 

Go back to the previous map extent. 

 Next Extent: 

Go forward to the next map extent once created. 

 Pan: 
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Allows you to pan over the data in your map by dragging the display in any 
direction with the mouse. To use this tool, move the cursor to any desired 
location, hold down the left mouse button and drag the display in any 
direction. 

Other Viewer tools: 

 Identify: 

This tool is used to display the list of information from the active layer.  
When a user needs to obtain more information about a selected map layer, 
they must first make the desired layer active.  Only one layer may be active 
at a time.  Thus, when using the “Identify” tool, only one table will display 
more information about the selected layer at a time. 

The following is an example of how to use the Identify  tool with the 
active  button to obtain more information about an active layer. 

In Figure 18 below, the user selected the PWS Well layer to be active. 

Figure 18 

Now the user may select the “Identify” tool, then single-click in the Viewer’s 
map frame on a particular PWS Well.  If you selected the “identify” tool, the 
“Identify Results” table will open for the associated PWS Well source 
selected in the Viewer (see Figure 19).  The user may close the table or 
print the table for further review by clicking the “Review and Print this page” 
button. 

 Figure 19 
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Note: The “identify” tool can be used on any map layer visible in the map 
TOC frame. To use this tool, however, you must first click the radio button 
of the layer and verify that the “identify” tool is selected before clicking on a 
map feature. 

Trouble shooting: The Viewer may lock up (and display hour glasses) if the 
user tries to do a zoom with the identify tool active. Hit the “Esc” key to 
unlock the cursor.  It may be necessary to close and restart the browser if 
the application locks up completely. 

 Legend: 

This is a toggle tool, which changes between the “layer” list and the 
“legend.” Clicking once on the button will hide the “layer” list and display a 
map legend in its place. Another click will turn the “legend” off and open the 
“layer” list again. 

 Measure Tool: 
 
When this tool is activated, the button will be outlined in red and indented.  
To start, press down and hold the left mouse button as you drag to the 
selected end point.  To stop, just let go of the left mouse button.  As you 
drag the measure tool, a line is drawn the distance your cursor moves.  At 
the same time, the values in the results box will adjust to the distance your 
cursor has moved in both miles and feet.  Once you have released the left 
mouse button at your selected end point, the results box will show the total 
number of miles and feet between your start and end points.    A line is 
drawn between your start and end points. You may either use the “Clear 
Selection” button or select another start and ending point for your 
measurement to clear your initial line from your map frame.  Selecting any 
one of the navigation tools on the toolbar (not including the following three: 
X-Y, Print Map, and Help) will also automatically clear the line you 
previously drew. 

 
 Digitize Points: 

This tool is used to digitize points on the map. It will trace the x/y 
coordinates of the features from the map locations. Select the tool by 
clicking the button once, and then click on geographic features or places of 
interest. You can then get the list of Latitude-Longitude coordinates for the 
digitized features by clicking on the X-Y button. When the tool is selected 
and active, the tool button will have a red box around it. 

 Draw Polygon: 

This tool is used to draw a polygon on the map. Select the tool by clicking 
the tool once. Single clicking on the map will create digital points that are 
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connected with digital lines. Double clicking will finish the drawing of a 
polygon. Clicking the “X-Y” tool will show the coordinates of all vertices of 
the polygon. 

Use the “Clear Selections” tool to clear an existing polygon on the map. 

X-Y Show Coordinates: 

This tool is only available after using the Digitize Points or Digitize tool. It 
allows you to get a list of X/Y coordinates for all digitized places, and 
displays them in a separate Web browser window. 

 Clear Selections: 

Click once to clear selections or reset the map. This tool is used to clear the 
selections previously generated by the following tools and search functions, 
“Digitize Points,” “Draw Polygon”, “Find PWS,” “Find Address,” or “Find Lat 
– Long.” 

 User Guide: 

This icon links to the user guide for the Viewer. 
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What other functions are available? 
 
At the bottom of the user interface, you will find the following search functions: 
Search map by PWS #, city, county, zip code, address, intersection, or Lat-Long 
(See Figure 20).  These search functions can help you locate a PWS well or intake 
with a specific PWS number efficiently and easily. 
 

 
Figure 20 

 
When you enter a city or county name into the Search by City or Search by County 
boxes displayed above, you may utilize the new auto-populate functionality.  The 
auto-populate functionality is also available when one enters a city name into the 
Search by Address or Search by Intersection boxes displayed above.  The auto-
populate feature works the same for entering the city or county name.  As a user 
types the first letter of the desired city or county name, a pop-up list will appear in 
alphanumeric order (See Figure 21).  If the first letter for the list of city or county 
names is long, a drop-down menu will appear with a scroll bar (See Figure 22).  
The scroll bar may be selected by clicking and holding the left mouse key button 
down as one drags the scroll bar up or down to the desired city or county name 
provided in the list. 
 
A user may select the desired city or county name located within the pop-up or 
drop-down list several different ways.  One option is to click to select the name by 
using the cursor on your lap top.  Another option is to click to select using the left 
mouse button.  A user may hover over the desired city or county name, which will 
be highlighted in royal blue, then use the Enter button on the keyboard to select 
this desired city or county name.  The text for the selected city or county name will 
always be displayed in royal blue text.  If a user does not make a selection, the 
auto-populate feature will automatically select the first city or county name located 
in the list.  To verify the correct name has been selected, the user will see the 
complete name displayed in the appropriate city or county box.  The final step is to 
click on the Find City or the Find County button to initiate the search process.  Use 
this same selection process to locate the appropriate city while searching to locate 
a PWS by Address or Intersection. 
 
 
 



 18 

 
Auto-populate City: 

Figure 21 
 
Auto-populate County: 

Figure 22 
 
Search by 
 

PWS #: Choose a source type from the drop down list and type in a valid 
PWS number.  Click the “Find PWS” button and the map will zoom to the 
water source with the desired PWS based on your input. The water source 
will be highlighted with bright pink.  An error message will pop up if an 
invalid PWS number is given. 
 
City: Choose a city name from the drop down list. The map will directly 
zoom in to the desired city after the mouse button is released. The city will 
be marked as a light gray color on the map.  The cities included in the drop 
down list are those cities representing the TCEQ Region office locations, 
which are distributed across the state. 
 
County: Choose a county name from the drop down list. The map will 
directly zoom to the desired county after the mouse button is released. The 
outline of the county will be highlighted with dark gray color on the map. 
 
Zip Code: Type in a valid zip code and click the “Find Zip Code” button. The 
map will zoom to the area with the provided zip code. The area will be 
highlighted as green. The highlight will disappear when you make any other 
manipulation to the map.  An error message will pop up if an invalid zip 
code is entered. 
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Address: Enter the street address and city and/or zip code (provide either 
city name or zip code, or both of them) in the proper spaces, and click on 
the “Find Address” button. See Figure 23 and summary below for additional 
details about the Search by Address option.  The map will be directed to the 
desired address and labeled with the address information provided. An 
error message will pop-up if an invalid address is provided. 
 

Figure 23 
 
Summary: 
Street # + Street name [Box 1], City name [Box 2], and/or Zip Code [Box 3] 
 
Intersection:  Use this search function to locate the nearest PWS(es) to a 
particular intersection by entering the name of two intersecting streets, 
roads or highways.  Enter the street, road or highway name into the box 
named, “Enter Street1” and enter a second street, road or highway name 
into the box named, “Enter Street2.”  Then enter either the city name or a 
zip code into the third box named, “Enter City or Zip Code.”  The final step 
is to click on the “Find Intersection” button to initiate this intersection search 
process.  If you are entering a street name into either the first or second 
boxes, it is only necessary to enter the street name, not the street # for the 
street name. 
 

 Figure 24 
 
If you are unable to receive results for the intersections entered, you may 
refer to the United States Postal Service web site for naming conventions.  
This web site may assist you with the correct format used to name 
Interstate and State Highways, Farm-to-Market Roads, County Roads, 
Route Roads, and toll roads.  For example, you may not obtain any results 
trying to obtain an intersection including a toll road.  Some toll roads like the 
45 and 130 located in Austin, Texas are considered State Highways.  Thus, 
entering SH 45 or SH 130 is the correct name for these toll roads. 

 
Lat – Long: Enter the latitude and longitude in the proper spaces in the 
format of decimal degrees or degrees minutes seconds. Click on the “Find 
Lat-Long” button. The map will zoom to the map area based on the 
information you entered. If invalid information is given, a message will 
prompt you to the correct ranges of latitude and longitude. 
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How to download the PWS digital data layers? 
Users may download a Zip file containing ESRI shapefiles for selected PWS 
layers. 
 
Note: the .zip file format is a data compression format used to compress large file 
formats such as .shp files. It is recommended to first save the .zip file, then to 
extract the files to a preferred directory on your computer. Each compressed .zip 
file will include html metadata files stating the projection and date for each PWS 
data layer. 
 
Step 1: You may initiate the download process by selecting the link displayed 

below in Figure 25. 
 

 Figure 25 
 
Step 2: Select the data you wish to download by clicking one of the links 
under Available Layers for Download displayed below in Figure 26. 
 

 
Figure 26 

 
Step 3: A window (displayed below in Figure 27) will open so you can save 
the zip file. 
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 Figure 27 
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How to obtain other data layers? 
 
The remaining data layers may be displayed in the Viewer, but they cannot be 
downloaded from the Viewer.  To obtain the remaining data layers, a user will 
need go to the appropriate web site referenced below.  Please note the 
disclaimers for obtaining the data layers outside the TCEQ. 
 
The following data layers may be downloaded from the following web sites: 
 
1) StratMap Transportation layer – includes Local Streets and Highways layers in 

Texas. 
 

Go to the TNRIS website to obtain the StratMap Transportation layer at: 
http://www.tnris.state.tx.us/datadownload/download.jsp 

 
Disclaimer:  The chosen base layer is only as current as the source from which 
it was obtained.  Updates to this layer are outside the TCEQ's control. 
 

2) Texas Cities – includes towns, cities and other county designated places  
 

Disclaimer:  Viewer should not allow public access to the Texas Cities base 
layer as this layer is proprietary data, which may only be acquired by 
purchasing it from an external source.) 

 
3) NHD Flowline – layer name in Viewer is Hydro, which includes Texas rivers, 

streams, and tributary networks. 
 
4) NHD Waterbodies – includes lakes, dams and other man-made water features. 
 

Go to the USGS website to obtain both the NHD Flowline and Waterbodies 
layers at:  http://nhd.usgs.gov/data.html 

 
Disclaimer:  The chosen base layer is only as current as the source from which 
it was obtained.  Updates to this layer are outside the TCEQ's control. 

 
5) TCEQ Regions – includes the most updated regions for the TCEQ. 
 

Go to the external TCEQ link to obtain the TCEQ Regions layer at: 
http://www.tceq.state.tx.us/gis/boundary.html 

 
6) Texas Counties – includes the boundaries for two hundred and fifty four 

counties 
 
Go to the GLO website to obtain the Texas Counties layer at:  
http://www.glo.state.tx.us/gisdata/gisdata.html 

 

http://www.tnris.state.tx.us/datadownload/download.jsp�
http://nhd.usgs.gov/data.html�
http://www.tceq.state.tx.us/gis/boundary.html�
http://www.glo.state.tx.us/gisdata/gisdata.html�
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How to contact us? 
Contact the Drinking Water Protection Team via phone (512) 239-4691 or email 
pdws@tceq.state.tx.us 
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